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e Utilities
A0 LN A R BT AR T g«

- Organize Reel
- Organize OMF %R F DVCPRO/DV
- Organize P2
- Organize PINN {%fEF DVCPRO/DV
- Delete Clip
- Format
- Repair Disk
- Repair Clip
- File Name
- Upgrade
- System Reset
- Diagnostic
- Status

* Functions

A5 R SO D RE A% B I, A H B fig 44 4 5 e
TVE, SR T A% D Re 0 B S B b B SO I - T
S 58 TWHIDIRESFRELURICE 215 5 .
e Setup

BWE T EM A FS-100 FLE 32 1F:

- Set Date (MM/DD/YY)

- Set Time (XX:XX:XX)

- View Firmware Version

- LCDLight ON

- LCDLight OFF

- LCDLight AUTO

- Alarm ON

- Alarm OFF

- Stop Frame

- Stop Gray

- Stop No Video

- EXT CTL OFF

- EXT CTL PAUSE

- EXT CTL FRAME

- EXT CTL FILE

- TC EXT (external)

- TCREC RUN

- TC FREE RUN

- TC REGEN (regenerate)
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TC SET

UB SET

TC DROP {ZRF NTSC

TC NON-DROP {¥FRF NTSC
LCD Contrast

« DV#®
PLF HDD A0S H T HDD Bk prik R R S L
AR
16¥% pvcPrRO/DV REC I, ¥ fon L F#%

RAW DV AVI
AVITYPE 1
AVITYPE 2
CANOPUS AVI
MATROX AVI
QUICKTIME
AVID OMF
QUICKTIME 24P
AVITYPE 2 24P
PINNACLE

P2

MXF O0Pla

e HDD Mode
@/‘MT@E@BZJJ%&@IH

DVCPROHD REC
DVCPRO50 REC
DVCPRO/DV REC
DD Drive

USE EXT FS-100

e Record

ﬁAu?iﬁ%JIﬂ

NORMAL REC
PRE REC Disk
PRE REC Cach
LOOP RECORD
SNAP

TIME LAPSE
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FIRESTORE
FS-100

PORTABLE
DTE RECORDER

H$EE3: FS-100 EINH)Es G BonERHE. RN EZA
B, %% 35 WK T 7.

[ ] STOP 1-
COUNTER T am

00:00:14:02
DISK 1 168 min

REEL
SYNC DISP LOCK

i HDD BREHER

$®B 1 FEESHIRA IR, HE% B8 HDD Mode.

HDD MODE

-DVCPROHD REC
DVCPRO50 REC

DVCPRO/DV REC
DD DRIVE 4

F®2: MHAT UL S s - FrskhLE A, DVCPROHD
REC. DVCPROS50 REC i{, DVCPRO/DV REC.
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24p 1AL F 345 DV-24p B &EX BIE .
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SETUP
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i) Set Date 4o
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FS-100 HA VU fil#E

Local

Al g FS-100 &S ik da i .

Syncro Slave

WFAHAL FS-100 25 14 il sk o v fih & D hg
PG AL A R . ZEXPIEEAR,  FS-100 KR
TEAEMLI SR PRSI B L AE . B CE SR B
WhIRHEAT Wy

AV/C

AV/C FT- PLAYBACK DL S A FHAMER FireWire 4 (Ul
DV NLE #4t) #H FS-100 M5 L.

Olote
IBJ1E FS-100 R &8 T {#EH Av/C.

Tapeless
LA B A% 55 FS-100 SEA A1 EB 42 i w6 ity
fil DI REMIEREHL (B an HVX200 BHEHL HEAT 54

PAR BT P P AT Y S 2 S (o

1.
2.
3.

B[] R H 2 A .
i%ﬁ%ﬁ HERE.

HEARYE S 21 WK FS-100 iE# 2 DV/HD BAGHLT
JaSH FS-100 EH: R 5L

PGP FS-100 &5 2 TF )8 »
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Olote

Tapeless Control
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B XHRBBGIBFTIFRIFE Focus Enhancements [k E [t A
http://www.focusinfo.com.
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Syncro Slave

CONTROL

LOCAL
-SYNCRO SLAVE
AV/C

TAPELESS

PR GE AN H A4S FS-100 3 28 19 A0 42 1 50 #d iy 75
T RE I EAGHL -
+  Syncro Slave B E R EEAZHL 200 AT Wby o
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-TAPELESS
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o RUUTEIEMEM TG, vl b () FoAth e I —i& 5 H

o RUIF RIS, MR T RANEIL SRR RER
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o TR RERE R, TP Kor.

SETUP FERIRRR
HIMERETE, AR
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B
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10. RIFFHFET

1F Record E¥, Playback #%3X, , I g 7 BU#5 Fr 7F sl bR ic
B[R 2 1845 . #5{F PLAY FROM > REEL LIST #250T,
REEL ¥ ILAERG 5 7, 640 [REEL]. # sk LT R4
#, WL,

1. B ERZE M Disp {5 B 7B

12. oo M Er s i oisp 15 BB .

DISP (BR) ERFHR

1] DISP DhREAZEN s M (S BB 11 f1 12, BoRrEds
B T44E#L, 114 DVCPROHD. DVCPRO50. DVCPRO/DV.

% 1 DISP F AL HEHE BF 4 o N JON I AE R R
DISP A2 r) I A it S R A it 2

FRES  BIERE/ QEHER

11 COUNTER

12 7R SR BB A S AT SR B AR A A A

11 REMAINING

12 Record: #3E#E ERIKFTAMEBAIEGE (URBRR) .
Playback: &7 %a50EHRIKETE.
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Playback: ZRHFEFHF#A DV ERSE.

11 UB NTSC

12 BTHTHETOEEREME. ERRUNE, DFRMRE
fiIfE, 55S%5 55 51k UB SET.

11 ABSOLUTE

12 BRI ESIER %X EEE: EiEa%E LTS COUNTER B
[B)AB B 2 F0

FE7E FS-100 & A AV/C #EFFERSMR FireWire i & (£l
WMITEND HITEEHI IR T 5 A 4 53 A (B AR 1E .

36 FS-100 fE#3 DTE &EM



FS-100 EOThBE

DV (NTSC = PAL) #1 HD
FE 1112 FRANESEMIZE LBURT Recorder Mode % & J fa f

B .
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DVCPRO/DV REC
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K=

RECORD

NORMAL
-PRE-REC DISK

PRE-REC CACH
LOOP RECORD

FIAE o B R FS-100 BEE N BRI (I TR
AL S ), S PR 1, Sl I SRR ds o

IR PERRIBGNZ S, BoRHUR OREF X85, H RS
AR O I 3B R SRR TR B £ B, A I S 1R A
e

TR HS Bk ML e A5 BEE A EF s IR, 15 &R L1
Je BERSY, BEAE BRI AR
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PRE-REC DISK | P STOP 1-001
PRE-REC CACH | STOP 1-001
LOOP RECORD ] L STOP 1-001
SNAP {XFRF DV #£5% u SNAP 1-001
TIME LAPSE {x/@F DVig | ® | T |STOP | 1-001

K LCD B 5 M IHEgE B, 1ES 05 81 1L LCD
BEA 5 F S
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PRE-REC # & FHIER

PRE-REC Disk

HDD AVAIL:
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PRE-REC TIME:
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PRE-REC Disk 5 XK 1 SEAF PR I AT SR il 21 FH 7 5 ST AL
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DUBT SRR AR Ji 221 B 4 4
» 1% PRE-REC Disk il & 1 Fr it (P AL 25 [ S ), B
Tl T =R 2 A0 IS Uy A0 455 B0 16 22 TR) 5 S o B ) 2 TR HY
WT IR
ANT 60 3B IIAE IR T B 1 4> B A IR R Bk A A T
o X 60 rEhEi UL ERTERS, FEEL 2GB B4 AR A
A
o XFFARLE 1 /NEYEIR, PRE-REC Disk £XLL— &4 1 4>
B B AR SRR A
o 5N, FS-100 #fgd.
«  DVCPRO/DV: 9 7p%f, 13 MET4E (HEAL L 2GB B745)
DVCPRO 50: 4 7%, 36 #0ByH (i T 2GB By#)
« DVCPROHD: 24r#h, 18 #b8y4E (fi#% I 2GB BY4)
«  PRE-REC Disk 1] 7 Local. Syncro Slave F/l Tapeless
IR,
« ¥ % 4 PRE-REC Disk Itf, FS-100 % o op #55
GBI
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Loop Record
Loop Record #3f6l-F PRE-REC Disko
Loop Record RJ K — Z8 41 WA BY 4 3% 48 by sy 1) 30 ) FH ) R 4 2 1)
o P A S AR BUJS s Loop Record FT45 LA HT 1)
B AR g L (1) B4
o FUABTER ) /NI TGP Bl B R
o AN 60 S BIFEER L 1 o BRI T A S
o I, DR LL 2GB By
o CUIRBIMEAL A PRI, K0 AN BT . B S BY
B RNBGR TR AL, Bl 1 23 Bhel 2GB. ZESEIL
UEThRe, WAL DIIA 30 2 b ] A1) .
RIFIEIIRHIBVEE
TEsk 231 4% STOP.
FS-100 15 1F 5% ) -5 2417 ) LOOP RECORD 4 8 48 {447 B i 4
A S

Snap Record {Z[RF DV i&E3{

i snap n] il B AN, 7E Snap BEAT, %
Record @ AJSRAZ AN, 7 [R]— 2 1 vh s il 19 o A3 it #40 OR AT A
— A
o BABNFT SNAP K TE, IR AEEE T SNAP LKL
][] STOP,
*  Snap Record {1 T- DV 1A%
* {F Local. Syncro Slave Pl Tapeless A R AE Snap
CPRIED .
« {F Snap SKHISUGIAR, WiJT FS-100 HJHJES FHCE
7E M ST A L 5 3R [P 21 Normal S Il .
Onote
RELIi B —HT55E

B —HEREVREBAY AR EXT CTL FRAME. BXi$MES, 55HE 52 7
By EXT CTL OFF. Pause. Frame. File.

FS-100 {@#= DTE BR# 41



FS-100 B9TheE

Time Lapse Record {ZfRF DV =3¢

TIME LAPSE

00:00:00:00

HH:MM:SS:FF < o= {TRTEZM:
XAT8%E.

S I A7 BB 4t DAY 2 ] (] R] % 5% 1 St i Sh e, 49 Qg 40—
Mi, 00:01:00:00 7B HAH6 ) N FH AT G HEEF X 30k i 4738 1 A2 il ot
T YT B ) AR KRR DA AR DR S SR AR SR .
SE I FATE TN BE IR (O F5

o SRR WIS B — A B

o YGRS UE 2 18] B TR) R I TR) RS DAV R, BBy 4>l

AN
o SR TR BRI R) Y 24 /NI

42 FS-100 fE#3 DTE &EM



FS-100 H9Th&EE

KRR
DV &3

DV FORMATS

RAW DV
-P2

I 5 B v R] e I R B P T sl i B R . dn 2R B
DVCPROHD REC (100 Mb/s) 2{ DVCPRO50 REC 1z, (50 Mb/s) 3%
il A PN T

« RAWDV

« P2
U1 LA pvePRO/DV REC R, WA — M 2k 1,
(e

DV FORMATS

RAW DV
AVI TYPE 2 24P

PINNACLE
-P2
MXF 0P1a

* RAWDV

« AVITYPE1

* AVITYPE2

e CANOPUS AVI

*  MATROX AVI

*  QUICKTIME

* AVID OMF

* QUICKTIME 24P {2+ NTSC
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* AVITYPE2 24 P {%RF NTSC
* PINNACLE

* P2

* MXF OP1a

Onote
EHF 25P M HAEFRIEN
F& AVID OMF Zz4b, BB 25P [T FFalE iR ER 1&g . OMF 5 25P
DV iA&A.
Focus Enhancements %3 I 41 H T 55281 32 5 DTE 9N H R 7 A
RS, MR SE: www.focusinfo.com.
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HDD Mode B%

HDD MODE

-DVCPROHD REC
DVCPRO50 REC

DVCPRO/DV REC
DD DRIVE

BEBE SRR DL I
« DVCPROHD
% #5K 1 Panasonic AG-HVX200 £EAE 4L (10801 Fl
720p) 1] 100 Mb/s Jii. i& 3R AR DVCPROHD 345 (1)
PN &
« DVCPRO50
YK [ Panasonic AG-HVX200 15 #5542 HL A I Aib
DVCPRO 50 fi N\ 5451 50 Mb/s ¥t
« DVCPRO/DV

7 ¥FKk B Panasonic AG-HVX200 15 1% 1 A1 H ik
DVCPRO/DV ¥ A\ % 7% #) 25 Mb/s it -

YRR RS
IR ERNER G RFERXEEF A Normal, 1ES % 39 TTHIFRAERH.

- DDDRIVE p

4 FS-100 JEHZ 2N VHE AU FH SEIE T, FS-100 ] HAELE
THENL BT WS . A, RE R SV £ A FS-100
TEAE — B DU 18 o St 25 1]
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46

USE EXT FS-100

NPT B A I S IR a] I, 5 EIE T . USE EXT FS-
100 FVFE PN FS-100 JERAE—ifS, DUERAET £ 1
FAFfE A A], SERUE R A S . — AN E AT AL,
HoAth 2 B 0Ty N B EREAXHBAS, HES
B L35, ARG AR 2ok 2 N B B rh

EXE / BRHEIRAEE /  NEE

L4 FS-100 &3 USE EXT FS-100 &7 —#2 3 4 F Record X
Playback 23\ Af, HEEXBRFHIBEHA, TRELWEBERER1-
xxx, HMBEERFISERT, MWER 2-xxX.
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&£ FS-100 F1M /8 FS-100

DTE rechmorooy FS-100 |
OF 00

COUNTER
00 : 00 : 00 : 00
DISK 1 000min

o B

it CONTROL owno

=
—

% FS-100

DTE recrmoroay FS-100
CONNECT
COMPUTER THEN
ENABLE BYPASS

SUCCESS
EXIT

SYNC DISP LOCK

A FH$E AL FireWire FE 2 Sk 1% 45 21 3 FS-100 ) DV IO
Master

REE b R L

5% %] HDD Mode 3% . bt %% Jf Ji Hl USE EXT FS-100.

{EH 6 &%) 6 £ FireWire HiZ5il i3 & ) Computer 1/O
ERARIERZ A FS-100,

Slave

R b 1) Ha R

1% % HDD Mode 3¢ )7 %51 )5 /| DD DRIVE.

Master

A% ] = FS-100 HEAT S5 il 4% i o
A #1£%) PC FHEF DD Drive #23

EiIREEER) BN Z AT, ikE FS-100 A% USE EXT FS-100
EXFEFEE.

Altt, &M HDD Mode R%E Hi%#¥ DD DRIVE
XEitEENERIREZIEEER.
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RER®

SETUP

10/10/05
21:10: 50

vV 1.0.0
-LCDLIGHT ON

BEE G LIS RIUL ) REREAT 70 2 o S FRIRUK D RESRABL TR ik
AL, RIS I TS SRR, JAb e IR AL TR
ZI R

ERLEIEBL T, Bl Date, <3 B — AU E Bife. ZENBE b4
HaR[El, AT BACK TRETLH .

BEE B L BRI I AT .

48

DATE 25 p
TIME 25 p
VERSION /2. NTSC/PAL 85 p

LCDLIGHT ON gt
LCDLIGHT OFF
LCDLIGHT AUTO

ALARM ON E2ti\
ALARM OFF

STOP FRAME ; (HEIBIEERIEE 1 1) Azl
STOP GRAY
STOP NO VIDEO

EXT CTL OFF 4EEiiA
EXT CTL PAUSE
EXT CTL FRAME
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EXT CTL FILE

TC EXT :gtik
TC REC RUN
TC FREE RUN
TC REGEN
TC SET p
UB SET p

TC DROP {%fEF NTSC
TC NON-DROP i\, {%FRF NTSC

¢ LCD CONTRAST
Onote
SR E B RRFAET 8]
WS E HEAFIRTE]. FS-100 XEHBMERSEREN. BSEF 25 TTHE
ErTEIFI .
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HHA
SET DATE
09/18/ 05
MM /DD /YY
BACK
At (8

SET TIME
10 : 50 : 40

HH :MM :SS

BACK
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FRZS
VERSION
1. 0. 01234567
NTSC
FS-100
LT S TAY

FS-100 A [E R A
K SD FA .
e FS-100 (51 =

LCD Light On. Off. Auto

XL RT R ] AR ] FS-100 LCD (15574
* LCDLIGHT ON égtik

—HATIFE R .
* LCDLIGHT OFF
T HERAE R .
*  LCDLIGHT AUTO
FE— X BIJERATE 54T, AR RRHZ BT AT T T 56T
AR5 S DR AT T 5T

Alarm On. Off

BINA on.
o A VBRI, % FS-100 LT RS A4 R H e

o YU R R L G A ) B S SRR, B
25l R FS-100 24 .
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o CWESRUT O off B, FeHLINHEE AT, FLH LA
i, o AR A T RBLIT, {52 HH g P

Stop Frame. Gray. No video

IXSBEE PE T FS-100 ££ STOP A5 T (AL S 1
« STOP FRAME Group Default
8 B AR 1) 2t
+ STOP GRAY
7 R
+ STOP NO VIDEO
gl Off.

EXT CTL OFF. Pause. Frame. File
TR T A VA FH AN % 4 ok nT ik () RS-232 H gl FS-100.

Ohote

A] M Focus Online Store i%l) RS-232 B4

1 FS-100 EIZEIMERIE SIS F T E Y RS-232 B 45 R Focus I HES =
CBLA-0113-01. 1t E4E LUK AR T At f 12 21 B9 E A B3 T A
https://www.focusinfo.com/sales/store £ .

+ EXT CTL OFF
i RS232C HLARIEFA MR & Il H e 1
o IXTER 3.5 22K DBY G2 L 4i3E A 2] FS-100 Control
i I,
7E Local #25F, & A PEIiin i FH ] 8 i A3 2R 1B 55 H ok
51 FS-100.

Ulef'ﬁlﬁfthU\lEﬂﬁﬁ'J% RS ) e
EXT CTL PAUSE
T8 3% il B AR B2 1 B[R] 4% ] Pause F1 Resume
e EXT CTL FRAME
KR PR TR AR TS i) B ST A o ROl BT RERY, 2
P AR s I 2 | —SCpkrh, B RS IE N IR,
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EXT CTL FILE
ST 2 9 TR QBT SO BN

TIME CODE EXT. REC RUN. FREE RUN.
REGEN

INFIA RS (TC) Thiedn .

Ohiote

TC EXT =ik

S N BRI A0S . S R IZ T iZ A [alAY,  FS-100 #f

LE s I A Aot A SR A [R) A B TR) P 5 o 26 % TC EXT

B, VBT CAFE 1 9

TC REC RUN

MU, FS-100 38 B J5 K4 ) TC SET {H )3 8 TC %4 11

Blo Ja SR B B n sk R 2 Jn . B2 TC 3%

R k) TC SET {H.

TC FREE RUN

HIhEELE FS-100 M TC SET A4 KB T 4R+ 5.

o {EIBH TC SET W, Aaf7fiimit TC SET 4 A I{H, FS-
100 AR ZM. REEE2Z)E, FS-100 A iR
% T

TC REGEN

24 FS-100 #£ TC REGEN ¥z N jashish, &0k

o BRHURIT SR i H AR AR

o XNZGEIN 1.

o TR RS AE Ky G AT A, e dn R RS TN — %
IS 15—l

wmRIRBh 28 A (RIAE ST IA 1% . B4

FS-100 ¥ff H TC SET {H.

TC SET #1 UB SET AEIRH&E
TC SET #0 UB SET XAANSHAIUEFIRE, EFLH (gl LCDLIGHT)
PARSHEERR.

HEREREFEIER TC EXT
WRFFESE D 720/60p HAMMKRES, SRRIMIREFESIFLU TCEXT
BRARTF, RELENFELES.
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TC SET

TC SET

00 :00:00:00
HH: MM:SS: FF

BACK

Timecode Set ZHUGAEH F e XTI [0 85 47 fi 7E FS-100 [W3E %
KAt . IR TC SET 2 )5, FS-100 B m] 37 RA4 FH %48 .
« TC FREE RUN
7F TC SET "X B %G, FS-100KH4E R HIHE F %45 .
« TC REGEN
T A FH A R A 1A T S5 S N PR A A
« TC REC RUN
T3 H S SRR S 2 TR A
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UB SET

UB SET
FF :FF :FF :FF

User Bit Set (hraEA7 ¥ &) ThHE AT H K 5 OIS 1 TR] A5 )
PR o

o AbT TC EXT BEUI AN S 15 i I A {E
ol W R A FH bk R AT ) SR AR VS I o s LA Bh 1B AT ) 39 Ak
B, #lan, EmEEAH T 2. A FS-100 #A —AMs
WA G NPT HAPLKME— UB W& . b5, nl RS AE
53k o2 BN AL I P o
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TC DROP, NON-DROP {Z[EF NTSC

XEESHANH T NTSC £, FF HARHR A Ge 3 H—1~24. Drop
F1 Non-drop 435l J7 I FIAE ] XM D e, b1y i vl 48 oo il 9 1)
HTllﬂﬁEﬂE’J‘erﬁﬁfE

TC DROP
i I ZE i L ge
o SRR AT 23 3R 00 R 01,
o Bs BENIEE 1 AN S E
e TC NON-DROP :Hztik
AR Mt o A5 S TR AN 25 oot I 1)) J5 ot 53 o) S T 1)
SRR ] o
ONote

{¥M TC FREE RUN 5 TC REGEN
O A{#EMA TC FREE RUN = TC REGEN & &/ A8 LLi&E TC DROP #1 TC
NON-DROP.
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LCD CONTRAST

SET CONTRAST
VALUE: 00

AL S e R4 LCD s B (6] be R LA (38 ) 1352
FTB1 i EE T4 #) SET CONTRAST [ i,
P82 A E ERET SR s R R T
Y3 EAJE, % BACK.

FS-100 {£#3 DTE &R
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DheE R =
DI FAL FB A FC S50 10 2R AT 5, 7T AR sz
ROCRE MPIHIT . R0 SRR MR IS R (5 L1

~ STOP 1-
COUNTER 1l
00:00:20:15
DISK1 168 min

FA FB FC
Thaeed

IREBCE A R e, JFRIAE “IhRe” Db viil. A “2h
AE " FHLE s B T B e e N R R AT A

FUNCTIONS

§-FA SYNC
FA AV/IC

FA TAPELESS
FA REELS

Fise s IThie 4 =4 FA. FB il FC.
HA AT
o Rt FIRRAE-ANEDUETESI .

o TRE
XEETfE
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ETIR
TR IR SE RS R B, PSRN I

£ LCD L&RFH:
FA SYNC SYNC
(7£ SYNCRO #1 LOCAL RHI=HIEX Z B 1#%k. B
FA AV/C AVIC (£ AVIC Fn LOCAL 24|z (81413
FA External EXTL (7 TRIGGER #1 LOCAL =%l Z ia i)
FA REELS REEL i#18 HRIMRIGH RS
FA RO-0 RO 1% HHIBI4B4RIC A Reel 0,
FA R1-1 R1 1§ L AIBTAEHRIC A Reel 1,
FA R2-2 R2 1% HBTBIEEFRIE A Reel 2,
FA R3-3 R3 1% HHIBI4EFRIC A Reel 3,
FA R4-4 R4 1% L RIBIAEHRIC A Reel 4,
FA R5-5 R5 1% L AIBT4EHRIC A Reel 5,
FA R6-6 R6 1% L HIBI4EFR1C 0 Reel 6,
FA R7-7 R7 1% HHIBI4EHRICA Reel 7,
FA R8-8 R8 1% L AIBIEHRIC A Reel 8,
FA R9-9 RO 1% L AIBI4EHRIC A Reel 9,

FA LCD ON/OFF

LCD1/LCDO LCD On/Off ]J#%

FA LCD AUTO LCDA/LCDO LCD Auto On/Off 1J#

FA BLANK FThkE.

FB DISP DISP (i FEH TC BRMER) (BiL)
FB ALARM ALRM/MUTE  (#TFF 8} 5] FS-100 £4R. )
FB FILE FILE (FEHREFERIHRZ @R

FB REELS REEL i#18 HRIMRIGH RS

FB R0-0 RO 1% HHIBI4E4RIC A Reel 0,

FB R1-1 R1 1§ L AIBTAEHRIC A Reel 1,

FS-100 &&= DTE 1EF#M
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£ LCD LERA :

FB R2-2 R2 1% HAIEI4EHRIE A Reel 2,

FB R3-3 R3 1% HATEI4E4RIC A Reel 3,

FB R4-4 R4 1% L BTBI4E#RIEH Reel 4,

FB R5-5 R5 1§ HAIEI4E4R12 4 Reel 5,

FB R6-6 R6 1% i ATET4EHRIC A Reel 6,

FB R7-7 R7 1% L BBI48#RIEH Reel 7,

FB R8-8 R8 1% L AIBI4E4RIEH Reel 8,

FB R9-9 RO 1% HAIEI4EHRIE A Reel 9,

FB BLANK FThhE.

FC LOCK LOCK/UNLK #iE#RsAEHR  (EKiL)
(£ LOCK #1 UNLK <Unlock> Z [8]#]#)

FC DV/DD DD (7 DV/HD %1 HDD # = Z & J# FS-100)

FC REELS REEL #3131 MRIEHHS

FC R0-0 RO 1% & A 814E4R12 0 Reel O,

FC R1-1 R1 1% L RIBI4E4RIEHN Reel 1,

FC R2-2 R2 1% HAIEI4EHFRIE A Reel 2,

FCR3-3 R3 1% HATEI4E4RIC A Reel 3,

FC R4-4 R4 1% L BBI484HRIEH Reel 4,

FC R5-5 R5 1% L AT BT4E4RIEH Reel 5,

FC R6-6 R6 1% L AIBI4E4R12 4 Reel 6,

FC R7-7 R7 1% 4R 51484R12 4 Reel 7,

FC R8-8 R8 1% L RIBI4E4RIEH Reel 8,

FC R9-9 RO 1% HAIEI4EHRIE A Reel 9,

FC BLANK T8

60
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ARBHEENE

COUNTER
00:00:20:15
DISK 1 168 min

BENTEE — N R
. REEL __ R2

ute Fa — .
%= FA REELS
ek FB HéE FC

% E 4 FB R2-2 ®EH FC R1-1
D Re & 2 — A sl B ) PR AR i B B 1) vk . Dhfg
SRR AP RS B R il LAEE ], 41 W FA REELS A FB
REEL-2.
 FAREELS
1 $¢ FA REEL & FS-100, H4BYHRARICLS AT 1% & 11 3%
Ba7 . 15 FA DIRe A e B m £ A+ T x40
« FBREEL2
K DI RE TR e v B IR bR, $878 FS-100 K 2411 5y
5L A JE T REEL R2.
Blank

FRUA Blank FIDIREAL TAREBIIRZS .

R1

FS-100 {@#= DTE BR# 61



FS-100 B9TheE

LAEFRR

UTILITIES

ORGANIZE REEL
ORGANIZE OMF

ORGANIZE P2
ORGANIZE PINN

T)EH S R P L 4«

62

ORGANIZE REEL

ORGANIZE OMF {%fRF DVCPRO/DV
ORGANIZE P2

ORGANIZE PINN {%f%F DVCPRO/DV
DELETE CLIP p

FORMAT p

REPAIR DISK p

REPAIRCLIP p

FILE NAME p

UPGRADE p

SYSTEM RESET p
DIAGNOSTIC p

STATUS )

FS-100 {#3#£2 DTE BREM
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Organize Reel

SR I T K BT A7 53 1 Ak TSI 1) B i REEL B 48 1) SR A7
&R EINA S 3 K BT VS S U ek S MU NE 2
DV NLE bin H1,

ORGANIZE OMF {¥fEF DVCPRO/DV

2L AVID OMF SCAH A% S il SCAF I, 38 I A VP 7 s il 25 0%
SEWIN B2 BT A 1Y OMF I AIF 854S0k, I AR R34 K
OMFI MediaFiles [ AE LI SCAJe b s G RE B BT STHLET,
Avid Editor [¥] Media Tool 23R A SCAFYE, VPR X EEFA
2| Avid I B £k, A RVELNE S, 762 %5 88 Tl Avid
OMF BYHH—1i.

Organize P2

BB TR G P2 s il Bl HI I SCAR 24, JRe sl iy P2 SCAE#3)
AN ) SCES2 R, DU NLE N AR m] Sz B ) 3y 7%
SCAFEE R SO CONTENTS 2 31 H s 4 ik

VIDEO.

AUDIO.

CLIP,
Ak,  Organize P2 2

¥ MXF WS4 2] VIDEO A,

¥ MXF &% 2] AUDIO LA,

¥ MXF XML 4% 3] CLIP Sk,

Organize P2 XS HI B Kfbi 2/
1T ORGANIZE P2 #1 BEFORE RHIF ZM MMM ETEZRE, BRI
HEFB gL, FHIEIT FORMAT EH#ERF.
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X

WSO T A 42 h) XXXXZB.mxf, L Xxxx h3E1{E, z hbE
MU EAF, B Rl 2% a0, AA IR R EEH .

F 2: MXF RH A BN IERH

Format B
DVCPRO/DV P
DVCPRO50 q
DVCPROHD w

TS AT A 44 0 XXXXZBAA.mxf, JLr XXXXZB 7 B 1)
MUSRSCHE, AA A TEEH .

& 3: MXF ESX i aTH

X A AA
L 1 00
R 2 01

A 3 02
B 4 03

ORGANIZE PINN {%[EF DVCPRO/DV

UEIETR ] 41 £A 8048, LL{EH T Pinnacle Liquid &% NLE £4;. £
% Pinnacle XA 2 2817~ 4, LAMES Pinnacle Liquid Edition
R . Pinnacle ST 2HE S 39 8] [] If 1) st =
AN, A AVIWBSCEE, FIPRASA BT . 435l bsid o 2 /R
TERAT FEIE I WAV S80S I8 RN S & s A B 2 — A
I ALE SCHF, & SO 5 i TRl A B o obb ST 06 20 B AR AR —
HEELRAT o

¥ 8745 5 N\ # Liquid Edition )5, A4AEREAE b o4 &R/ By 4R 01
—> Index (Mo ANEHERICSCHE, PEOAFERELCIT H rh 4k 2l T4E
i 75 EE S
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Delete Clip

DELETE CLIP
CLIP 000

YES BACK

A5 FH S 50 mT H i  2 1) BY A
S NS HRETBF 5 2 DELETE CLIP Ji# %,
S 2. fFHEENET SO N M 5 R B e .
HIE 3 % YES DyfResk.
B a] B 5 FI BY 4 .
$£IE 4 i BACK IR[1] ] Utility e,
MR B4 2 5, FS-100 K 55 41 23 34405 S 38 4 i BT 4E . 5]
n, SR B = ANETER: 1-001, 1-002, 1-003. A1 MR T 8y
1-002, W< FHr 41 2300 A A BT 48, BU%E 1-003 AZ BT 4 1-002. 1H
SEFEAR A A AR
Olote
IR SR T 4
5 FIMIBR BT 4B TN BT B S MR AW, TP R 22 B T B S 2 MBI
SH. EXHARAH TR ETESHATE,
« M DR-HD100 {£EiFr B N A -
« 1T FORMAT L1255, 155185 66 71AY Format Disk.
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Format Disk

FORMAT DISK

PRESS YES TO
ERASE ALL DATA

YES BACK

FERFR R 1 21, T IR 30AE FS-100 KB 1k 3= S0
TEE

A BRI ZAREXHY

BRI SRR EPTAEIE, FAFARE. BESAL
ZHIEH FS-100 LHYFTE SCHFNETEE.

eI TR A GRS, a0 R TR
S LR BE %4 3] Format Disk.
S 2 %k YES, FFEKAAL.

5]@%%*4%%&@%, ok A ERE, AR SE R R
HIE:

- Complete %5 Repair Disk (EHE#AE) ClIh5Ek.
- Aborted F/R ISR, BERTEK.

HIB 3. i BACK iR [H[ %] Utility b .
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Repair Disk

REPAIR DISK

PRESS YES TO
REPAIR DISK

YES BACK

QS S 2 1 AR A 58 BT ELMRBE S RT RE AR, 154 k)
fe. B, skHlHT FS-100 A R M k. Repair Disk 41
AL IR SN 3%, K B AME & SO R AN SR 1 S . S
B )5, BIA{E NLE &4 .
Olote
RIS EER— SRS
EiE1T Repair Disk /5, RLTHAGNABEEH—SHTIRE. EXHIE
T, 1&iE1T Repair Clip LR, HESE£ TR
P G
PE 1 NEHFT bR F] Repair Disk.

S 2. %P YES, FS-100 B IFE1E S .
%H@jfﬂ*“ﬁt%&}ﬁ%, WoMERRIEE, RS EoR
W

- Complete F/x Repair Disk (BRWEL) EII5E K.
- Aborted FoR HHETE, BE R,

$IB 3: % BACK iR [0] F] Utility %,
HIE 4 M FS-100 T H M2

LS FH-PRWZ R, EEH Format Disk sEHFET . MED IR
AR AT A, WS U5 66 1L Format Disk.
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Repair Clip

REPAIR CLIP

CLIP 000

YES BACK

5 e Dy e v B 5 LB IR BN SE BE IR e e S o, SRl T
FS-100 HEL A M al, AT e O i3 . Repair Clip #4471
Az e SO, R A AME S SRR A 538 ) S . B R
J&i» BUAIYE NLE &G

S
T2

TE3:

TE 4.
SIES5:

LI 6:

68

M HIFE T b #4421 Repair Clip.
ff @ e @ T U AN S 8 g5 .
% YES, FS-100 K iR E 1.
ﬁﬂgﬁyﬁﬁ\%%&}ﬁ%, BoEE M, SR B
:/V/L‘:\:
- Complete %5 Repair Disk (EERAE) CkIh5Ek.
- Aborted /R B R, B RTEH
% BACK i [H] F] Utility 57+
M FS-100 H15%5 H P 7%

(ERE— 22 07, 153 Format Disk SEH Ry . MWD
PR AT A%, TS5 66 L1 Format Disk.

FS-100 {#3#£2 DTE BREM



FS-100 H9Th&EE

FILE NAME

FILE NAME
CLIP 001

20041101 -
165423

Rt gR A4, HA RV SO .
T NEHRET bR 3] FILE NAME.
g2 BT SISO B
PEA B4 g 5 1 — TN fE, B & BRI 4
WHR B 2 A0, B R — AN EARS 4
HIB 3. % BACK iR [H[ 3] Utility 5# %o
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Upgrade
BRI T 20 A0 8 R34 56387, 1575 1) Focus Enhancements ¥ i

www.focusinfo.com.

TR R G A
$£18 1: i )\ HDD Mode /i %44 FS-100 ¥ & 4 DD Drive R {53
EREL L

S 2 FEiFENLE, B XXX bin X E A4 N f5-100.bin.

I8 3. 4 FS-100 4T DD Drive #<zUHS, K £5-100.bin SO & 5,
Hajik ) FS-100 .

$E 4 ik FS-100 JE i DD Drive #0503 5 R 3 B o
W5 SR b A ] Upgrade.
SR6: LEETTE. KRR R

kL

UPGRADE

PRESS SELECT
TO UPGRADE

SOFTWARE
BACK

SIET: 1% Select .

T8 Kot bR 154 YES 4REL,
Bt — RS, Bos TR L

UPGRADE
UPGRADING ...
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FS-100 H9Th

HE

£ THEIhE RN,  FS-100 ¥ Bl B

UPGRADE
COMPLETE

PLEASE RESTART

$18 10: 1441 STOP / POWER OFF %4l i 4 FS-100 XA .
LB 1. B3 FS-100.

HRBIR
HURTFRRIE,  FS-100 # SR AR Z

UPGRADE ERROR

WRONG PRODUCT
ID

BrAE M G Y TP B K H AR FS-100 5. ARG

PATHHT, LR AR E 1 H RS s

FEAFR FS-100 B E RS, i3] SETUP JJf 4%, ARG 55|

version Ji#HE (V 1.0.0), 1ES %5 48 TUI B E Hf 4.

FS-100 {£#3 DTE &R
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UPGRADE ERROR
FILE NOT FOUND

WAF TR S 44 15 A £5-100.bin LA A A& 75 40T FS-100 Afid:
HIAR H s

System Reset

SYSTEM RESET

CONTINUE TO
RESET

SYSTEM?
YES BACK

System Reset LI REWK R FS-100 3B ) BINBCE . HLIREAE S
WA L 1 ) LN AR AT

A System Reset

System Reset &g @1k

Diagnostic
A ENERULTHEEEIRE

12 W

pain

A5 LI REE A T #5 B Focus Enhancement 7 AR 32 #§ A
FS-100 nJ g H I F 1] 51
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FS-100 H9Th&EE

FS-100 IR 75 B FE 3 AT 56 R 40 s YRR 4 DL A P e P 1K) 1R 40 45
B BHEBFHE ] 75 B Focus Enhancement 37 A SCHE B3y o 20 i 1Y)
FEL YR 3o B i R
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RBER=

PEAERE A2 )5, FS-100 K5 AEm AL AU 10 D30k, 45l
0-9o FE I BCHR I AR I R], AT LUK BT AR A7 A SO e, Bl
HMNEZ 10 AR A R BT

XL A FR e 2 AT A 10 N3 B 44 Ok,
G AUEE DD Drive BEUJEKE FS-100 M85 27150

RBEFRAERGT T
M Reels JFHE IR 7 B P AR

S SRR hE 55 2 Reels HiFe
A5
- FARO-0 EiAE
- FARO-0 #| R9-9 “F{gii%”
L2 NFIRPIERE ARG
BT P s Gl 2 Ja, AT S g bn i 2 A it
Ho X LA R g by 45 1 Esd% i
A DR RES D e Bl e 4 (M kA%t , DUIEAE 2 N sxA%aii 2 1A
PRIED e B2 v DA ARG . 1ESHH 58 I IIRE BT 7
PSR 245 5o
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FS-100 H9Th&EE

ERAL&KER

A AT 3 A e R 4, A P 42 T AR LA 2 S 0-9 FRic BU4R . 78 %
T B A I e T AR A B A R AL, R Rk S B S AR . SRR
J5, %3 Utilities 5E %=1 () ORGANIZE REEL. #7510 [ BT 881 1k vk
AETAE R AG A

WP 2 ), BB RS PO B 5 AT B e — AT A2
M 7S sRAR AT A FR, TS 78 TUK LOCAL.

Oliote

B B (p/n ACSS-0019-01)

BEiTMA %ER, 1545 Focus Enhancements i :
www.focusinfo.com/sales/store/.

FS-100 {&#3 DTE BRE#¥ 75



FS-100 B9TheE

9T

76

PLAY

PLAY CLIP
LOOP CLIP

LOOP ALL
PLAY ALL

Play Clip

WA, 49% F PLAY 42411,  FS-100 %Mk 5) 2
TRURFE 0L € I BY 5 . (R 1% 878 145, FS-100 815 .
Loop Clip

RS, FS-100 ¥ Mk 2 R #80% & i 8 45 . /25
WAEGE S, FS-100 LRI E R E YA, mAS
. EHREFXARES, BRIk,

Loop All

TEMERIECT,  FS-100 H4 4% BT M Sk 21 & 5 50md 35 1)
i WA (I 8948  fEika — N8I R, FS-100
PN — B I SR BRI, MASET. ©fF
RFFIXARES, HRE IR

Play All

FEMARECR, FS-100 H4 4% HEF M Sk 1) 2 FR soidAs vh r) fr
HNE A o 78452, FS-100 %815,

FS-100 {#3#£2 DTE BREM



FS-100 H9Th&EE

PANE S

PLAY FROM

TRACK LIST
REEL LIST

DU Hf S SOV IE PR BT AR R TR a7 B A AN I
« Tracklist (g§B%IFR)
B 22 SR Tl PR U 46 5o 4736 3000 331 SCAH 44 BT o
¢ Reel
Rt e SCAEJe b 8y # . L D) RE AU VFAE MG AT R
SO 2 AV REAT E R . SO e ] BRI P FR e 1 SO
JeFR (FEAERHPITE) o
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FS-100 B9TheE

=HES

CONTROL

-LOCAL
SYNCRO SLAVE

AV/C
TAPELESS

P57 T 1L FS-100 £E% AR LUTLA AN Rl fi 0zt
* LOCAL

Local Pl B 2K FARYLI SR Bl A ds, 5E4 M FS-
100 i TR A Y R] JE VAT 238 P2 B 7 il o

e _|

BRER
(BMFEEH)

0-9 Fi&TH —
wmS

78 FS-100 {#3#£2 DTE BREM



FS-100 H9Th&EE

o WA S FS-100 ERBEAH.
«  fliH] Keeper v HFHUAI AR B, Wit METE
PERAZ N 3, W% T Keeper H548 H 58 ok sk 1471 4.

FUE I T FS-100 14 215 p/n ACSS-0019-01, 1117 1]
Focus Enhancements [1 % 3if; :
www.focusinfo.com/sales/store/ .

* Syncro Slave
MFRBHLBAT 5 FS-100 AHAMEA (1) FMH 2 il 4 3G g A i
RIAERS, . 7E Syncro Slave LT,
FS-100 18 ik o 45 BEAZ ML R 717 i PR S SRR B AZ ML I
PRAE.

« AV/C

Ohate
BAERHERTER AVIC #2428

ERR ISR FS-100 HAMES FireWire %% (UIASCREH
FEOMERFIAR T NLE 240 #2HI0 HAh 550~ H AV/C.
FEIXEAE LU, FS-100 v K H S5 3G ML 5 vk 0T
NLE K45k
* Tapeless Control

WA FS-100 e 25 B JCHE 2 A& ot 137 Tk A& 4
(1)1 E, Tapeless Control 15 ¥ 7 1F MAEAZ ML 4% ] FS-
100, Z PO LEEIR Panasonic AG-HVX200 1 ] 1458
R

Tapeless Control &3 BB GHER

FRAEB G SIFFH A RGN T2 EBEHENX T, BN Tapeless
Control I TLEZTE. BXIFMES, FEERGIFMH.
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LCD REFHFSXF

N BRI R R B £ FS-100 $istl . B
AL AR BRI SR 7E LCD BT

PLAY/REC MODE FS-100 LCD
Stop STOP
Pause I PLAY
Play P> PLAY
Rec (Pause) Il REC
Normal Rec (Rec) REC
PRE-REC Disk (Stop) P STOP
PRE-REC Disk (Standby) P REC
PRE-REC Cache (Stop) c STOP
PRE-REC Cache (Standby) Cc REC
Loop Record (Stop) L STOP
Loop Record (Standby) L REC
Loop Record (Rec) L REC
Snap (Stop) STOP
Snap (Standby) I SNAP
Snap (Rec) I SNAP
Time Lapse (Stop) STOP
Time Lapse (Pause) I TREC
Time Lapse (Rec) T REC
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LCD R&EFHF ST

PLAY/REC MODE FS-100 LCD

AV/C* (Stop) A STOP

AV/C* (Rec Pause) I A<REC TYPE> REC
AV/C* (Rec) A <REC TYPE> REC
AV/C* (Play Pause) I APLAY

AV/C* (Play) A ALL

Syncro Slave (Pause) Il Y<REC TYPE>REC
Syncro Slave (Rec) Y <REC TYPE>REC
Tapeless (Pause) Il E<REC TYPE>REC
Tapeless (Rec) E <REC TYPE>REC

* AV/C AT FS-100 3&E4 2 vH HHL R G % o
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FS-100:
EHBWESFER

BALSRETAE R HIE) FS-100 P2 /5, RIAT£ET DV/HD NLE REH %
It BN LEAXLEE. ATHEFUTHE:

BRI oot 84
TE WIindows TZZE FS-100 ..ocooiiiiiieeceeecee e 85
FS-100 F0 FAT 32, 87
fEF AVid OMF BTAE ..o 88
ENEL FS-100 (WINAOWS) ...eveviiiieciececreeeee e 91
L% FS-100 (Macintosh) ......ccccooeveeiieieeeeceeeeeee e 92
ENEL FS-100 (Macintosh) ........cccceevevieiieiieceeciece e, 93

2, BEAE NLE RGP MBSk, 2008 i AR 4L R ok
KRGS, oo N BT R . 6T R 8 DV RIS 4L p2
25 NLE 2480, FS-100 DTE e H TiXx—FREME. B
TSSO N FS-100 B 21 H S ML BRI AT,

SRR NLE #ET R

WRAER) NLE &5 Focus Enhancements DTE z#, M@ 41{EH AV/C
RHIRREMINE K, LUMEHITRE.

BREMER, HSEELET8TIH “BHRERE" .
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FS-100: 5HHENESEH

TSR FS-100 B R0, 1
+ Bt FS-100 1) Computer /0 1394 ¥ | H $3% 3 LAV 3) 0
OHCI %% IEEE-1394 FireWire ¥fi; I )2 T 5 FireWire 2%

KR SR L.
ONate
EZfER

BRRAMMESLIER, 1B FOCUS Enhancements M3
(www.focusinfo.com).

o WREAIH] FS-100 HDD Bypass £2:0, 5Z% F 3 T fif
FEEZEISY

FS-100 7] 54F{i] figfi% 132 B FAT 32 & 1H SN RS 2, il tn
Windows 98SE/ME/2000/XP LA & Mac OS9/0S10 %5,

VAR E
S fFHFRUE 6 413 6 % FireWire 45, #itH COMPUTER I/O
1394 % L FS-100 MR THENLR S

S 2 # A HDD # X /3 H DD Drive.
PRI FS-100 225 BT AL /(1) 75 0 5

+ fEFS-100 I, A\ HDD J##.
* 1&$% DD Drive, Jfiliid @A77 MmN Connect i %
* 1% Enable Jhfigfu4l.

HSHH 43 UK R 1.

S 3 Al HFRAE 6 £ 3 6 £ FireWire 1145, #1131 COMPUTER I/O
1394 i HEf FS-100 E 2 THENLR S

P4 W, RIREhasE R,
PSS HEUEH I THEZER.
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FS-100: 5HHENESFER

#£ Windows T %25 FS-100
eI FE T Windows XP. 2000,

TE1:

98SE Fl1 ME,
E3T Windows MITHHEMNLARS L, XGh sl A FAK

Computer Bl Fx. BLIPEEATHF—NH K% 1.

T
o My Computer

Fle Edt Yiew Favorites Tools Hslp

Q= - B _pSearch [ Foders | [i31]~

My

L]

Address | 1§ My Computer

len

e
J&31% Floppy (8:)
e Local Disk (1)
s Test (D2 Local Disk
S FSOB3004 (E2) Local Disk

_ “@Removabls Disk (F) Remowabls Disk

| Type
System Tasks

Wiew system

information

Ty Add or remove
programs

B Change o setting

Local Disk

Other Places

8_] My Netwaork Places
@ My Documents
@ Contral Parel

344-Inch Floppy Disk

| Total Size |

115GB
23368
93.1GB

Free Space | Comments

58.1GE
21568
14.9GE

S 2 K F) FS-100 KB 2 AT FFE -
W, s AR UEY FireWire RESLIREN 2%, Tl EEbRIE N
E:. F:.. G:%,

L FTIF FS-100 2% B Fr .

62 FIF A fcdlr H IR i) se sk .

BN

Fie Edt View Favorites Tools Help

Qe - Q- BF p search 2 Foders | [ 37 X ¥) | [Ev
Address lv EL

Name ~ Size| Type Date Modified
[=1] File Folder 7/14/2005 3:53 PM
&1 File Folder 7/14/2005 3:53 PM
@2 File Folder 7/14/2005 3:53 PM
&3 File Folder 7/14/2005 3:53 PM
24 File Folder 7/14/2005 3:53 PM
@s File Folder 7/14/2005 3:53 PM
(=13 Fie Folder 7/14/2005 3:53 PM
a7 File Folder 7/14/2005 3:53 PM
(=1 Fie Folder 7/14/2005 3:53 PM
@29 File Folder 7/14/2005 3:53 PM
£20050803-164513-01 File Folder 8/9/2005 12:40 PM

log File Folder 8/3/2005 4:47 PM

[B) Desktop DB 480KB Fie 7/14/2005 3:53 PM
[B) Desktop DF 64 KB Fie 7/14/2005 3:53 PM

FS-100 {£#3 DTE &R
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FS-100: 5i+E#HE&ER

SRS JemT et 5 2 AN AR SCPE . SUMBTA W] BEQ N s

Fle Edt View Favortes Tooks Help

Qe - © - psearch [ Folders | [ 3 X ) [~

Address & E:\20050803-164513-01 v B

N 20050803-164654-01.dv N 20050809-123952-01
DV File MOV Fie

24,141 KB 63,104 KB

1y 20050809-124027-01
MOV Flle

38,800 KB

* RawDV (.dv)
* AVIType 1 - (YYYYMMDDHHMMSSa01.avi)

s AVI Type 2 5% AVI Type 2 24p -
(YYYYMMDDHHMMSSb01.avi)

* Canopus AVI - (YYYYMMDD-HHMMSSbO01 .avi)

* Matrox AVI - (YYYYMMDD-HHMMSSmO1.avi)
BESCAFEREA F LB — S AR wav T3P

* QuickTime 5% Quicktime 24p (.mov)

+ Pinnacle - (YYYYMMDD-HHMMSSp01)
AL EARAT I BAE) wav E ARSI

* Avid OMF (.omf)
OMF {ERAS L A A SR aif 4001

* MXF OPla - (YYYYMMDD-HHMMSSa01.mxf)

* P2-(YYYYMMDD-HHMMSSpO1.mxf),

(YYYYMMDD-HHMMSSLO1.mxf), -  (YYYYMMDD-
HHMMSSRO1.mxf) H:H:
p A,
L A 7efEiE,
R NAFIE,
ONote

FEIRHLHET B FS-100 1575045

FS-100 ftiF 15 SR BTE M B AR E X R R & XX
F. MREBNINEEIEEERETXHET, &% FS-100
EENTEH EZ A, ®HSEIET Organize Reel,
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FS-100: 5itEHNES(EA

HD &##EEFnma
e P2:YYYYMMDD-HHMMSSX01.mxf, A" X 2= KA
AR . RN T T F R R AR M R

Format B
DVCPRO/DV P
DVCPRO50 q
DVCPROHD w

o BEAh, P2IRGUFELAR 4 NSO

YYYYMMDD-HHMMSSLO01.mxf Left Channel
YYYYMMDD-HHMMSSRO1.mxf Right channel
YYYYMMDD-HHMMSSAO1.mxf A Channel

YYYYMMDD-HHMMSSBO1.mxf B Channel

FS-100 #0 FAT 32

FAT32 U RS IR € T SCAFH5 KA 2GB, MR s A R 43 B
PIAIE, BARKNEVFSIEA 225, (R KA T LUK
(AW

DVCPRO/DV 9 34

DVCPRO50 4.5 /34l

DVCPROHD 2.2
AR KN 2GB I, FS-100 2 A A EsE i cft, HAE
PATATT o IX PR ST LA A R AR SO 42, (A T8 I A1) g
G F 8 7 G BN, 1 -01. -02 25, HRPRIRE)2SRetl 259N I i
K, iR % nT LR R 2GB 781 S
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7£ Windows X Macintosh 154l A K24 DV FiF £ P2 3
7% NLE RGN, ¥Jn] DLEERT R] 2 ) A X 28B4 . ERRJRG (i
CLEREN FS-1000  L)8Y4E, JFHH H#5 N\ NLE bin ',
OB B R AT NLE B[R] 2 Ny 3745 0] FH .

FS-100 X & 4% HAT e A& S g &, Jo ViRe SLBIIAL B 92 3 A 2
NLE, SXFEFUH R 1l X Le By 32 il 2o 223047 52 1 i A i 1

g‘o

£ Avid OMF 5i%§
fiEH) Avid OMF #% AR BTARIN, XL BRI A T o

Avid OMF 3 #% 202 £ 7 Windows 2000, Windows XP 5¢
Mac 0SX b8 1] Avid 4 45 dh 0T A [ IX487% f A 4 Avid
Xpress Pro. NewsCutter Fl1 Media Composer Adrenaline (777 DV
I .

Avid OMF kg 2 R O g = AN S0, —A4> OMF #8534
RIPGAN Bk ) ATF 450500 o AETHSRLE T b, IR S R b
NR o

O el

Fle Edt Wew Faverfes Toos  Hep "

7| sewn e X9 "

7£ FS-100 [, FHSC: (OMF) FIS5 830 A: (AIF) BontE— i
L7

B Avid OMF SCAFIE, FS-100 tH45 1) s I B3 2 43R0 RE A3 49 o
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FS-100: 51+ E#E &R

FAE Avid NLE R4¢ LA FS-100 5110 Avid OMF SCf, 138
fEEL R
Olate

ORGANIZE OMF Th&k
WMRTENE FS-100 EZEZ T HEMNZAIER T H ORGANIZE OMF Tk, WA
2B LU T 5% 2 FI5 9% 3

S BT FS-100 3R a8 0
W2 B SR eIk Ay 44 8 OMFI MediaFiles .
SR 3. TEAE Windows _F5E b ERE, %4 File>New>Folder.

IR 4. TAE Macintosh 5 #E1E, % 4F File>New Folder.
SR 5\ OMFI MediaFiles .

LS KT OMFE Fil AIF SCFHE 4858 3037 -
YI#E34 4 Desktop DB 5% Desktop DF HI3C#:.

L6 JHBh Avids
LSBT HA—NUEIHSGH R —ANH .
HIE 8 EFE Tools>MediaTool. F 5 RU1 R N 21 54

X
Vedm Orwnin| Progectas]

[ 0

TWEWRCI D)

= @ venr (s
o | Precerees (308
. Neau Fies
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FS-100: 5HHENESEH

U89 {F Media Drive(s) N3k #|3i%$% FS-100.

MREER TR

WMRSHRTIENE, BREFHIREEE LB E
EfEIET OMFI MediaFiles Xf3£. 1th5h, EFiEEIEIRE
BEEMREEFEHITEMNIRA . 7 Project(s) T, &% All
Projects (ILE{EBFERER Project(s) O FRIFTELTD .

IR 10: #ifR Master Clips CUET, 4% OK. B Rl FAE
#) Media Tools % 1 :

e
e Tmudd R el
b Tracks Ear' Erd g Mgri
1Al SIALAETE STAEEa by hEE] s
= mm—l!m:‘ﬂl Wlald Iisfshwd  FeEgagr - S H
T IS WAl-s T4T4EE  Z214ATH Znas
i
| T r—— [ 3

S 11: B bin GEFE File > New Bin) Ei7E Avid 3T —

MNILA T bins
SJUBR 12: 1EFE Media Tools & L HIFTHA I (IEF& Edit> Select
AlD .

S 13 # Media Tools & H AN ZHEE] bin H. ILE, BAS
7E Avid I [R) 2k Al X Se BT 48 T,
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FS-100: 5HHENESFER

EDE; FS-100 (Windows)
FS-100 FITHHNBC S B R G, 7 MR G EIE FS-100

A % Z HiEE FS-100

TEXM) FS-100 BIRZ AT, RFEM Windows RFEHEIEIZEE,
R—RmEXREE.

PEEIZR FS-100, if:

TE1:

iﬁ\mmWsE%ﬁETﬁMQQW%ﬁ#Eﬁ,WTE
o

& > (@S 12:13pM

% e A E R
(REMmEREHD

Wa, IHEILRGRAR MR CERR FS-100. FEJSTTAG
GElEC SUR

I B I

THEHLEISE FS-100 2 okt s — 4008, RWBLERT L
LAPREE.,
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FS-100: 5i+E#HER&ER

=% FS-100 (Macintosh)

S 1. 33 Mac W HML, AR 6 £ 3] 6 £ FireWire FEZ5 FS-
100 COMPUTER 1/O 3t [13ERE R 1155 HL

wAESE R, VAL N SR FS-100, W R FTR:

M == o) Fri85S6AM |

FSO83004

FS-100 ¥ Won A4 PC bric i) FAT32 4.
E ST FFF] FS-100 IEEHFTIT.

T A B AR R Se 92 (ilan,  “20050127-110345-
017) o B/ARNZEW FITR:

[~ 20030831-072915-01

<« v ][z m] (2]

§ %
5
w N

B

(Q~local disks

@Netwurk - z i
@ 20030831-072917-01L.mov
g Macintoesh HD [@ 20030831-073322-01.mov
@ FS083004 & [@ 20030831-073457-0L.mov
[@ 20030831-073505-01.mov
umskmp [@ 20030831-073508-01.mov

@ 20030831-073514-01.mov
@ mattmcewen :

A Applications
Fj Documents
ﬁ Movies
& Music

Hﬁ Pictures

6 items, 35.75 GB available

% FS-100 EEZ T EMN ZA]
MR EGHERERIRGTXERT: EHREEEZITENZAL
&% 1T Organize Reel.
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FS-100: 51+ EHESER

EP & FS-100 (Macintosh)
FS-100 HI Macintosh AL & 8 G, T MR 0L E

Zl % Z HiEE FS-100

XM FS-100 BIEZ B, FEM Mac RAEHEIHIZLE, X—
EEXEE,
P\ Mac HEIZL FS-100, 1
$BA AN B FS-100. ‘E45fT PC £ 5.

PR 20 R UK 4 [Pt A T 5 o R R A T R
G KB a5 o

S 3 WAEWRLZ4eHH FS-100.
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REREMH

1% FS-100 2L E=FE&H

A P TC AR L 22554 (P/N ASYF-0849-01) FJ#4 FS-100 %
REGHL E. AREMREZF B ET W EMS,, FY
Focus Enhancements I % :

HiE: 408-866-8300

ik Focus Enhancements, Inc.
1370 Dell Avenue
Campbell, CA. 95008
www.focusinfo.com

INEESH L

RHERER
IEEE mEmE

FS-100
ik P :

FS-100 Pffis 1 — A Bali 236 M Me S ABh 176 I B 485 7 T
Pt R I (405 25 o K SR IBC A 22 3 E FS-100 T [T (1) B4y S 3L AE
b JFR R ES), AR R I T RS A AR R AN
AL F.
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BARRE

WS AT RERERS S BB
B PU

JUF: 1.59 Jis) x 3.74 9i) (40 22K x 142 =K x 95 =
KO GirbrvEr, 90 438
HE: 1f 045 T30

MW/ Hit

DV #45i 1/O - 400Mb/s (1x 6 £ IEEE-1394)

1£ DVCPROHD REC 5T, 1%3&% ] ) DVCPROHD #f¢
R (0 Panasonic AG-HVX200 #4481 ik 720P
A1 1080i 414

FireWire 11541 UF - 5 400Mb/s (1 x 6 £} TEEE-1394)
DVCPROHD. DVCPRO50. DVCPRO/DV 35 [1%mA:

DVCPROHD

4:2:2. 84, 6.7:1E4E%E, 100Mb/s

1080 60i (30P, 24P, 24PA), 720 60P (30P, 24P) NTSC #&
1080 50i (25P) , 720 50P (25P) PAL & &

*O)RFRER - GERRPSTR

DVCPRO50
4:2:2, 81, 3.3:1 [E4E%, 50Mb/s
480 60i (30P, 24P, 24PA) NTSC 5
576 /50i (25P) PAL %45
O RS - CH A AL
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DVCPRO/DV

4:1:1, 81, 51 JE45ZF, 25Mb/s (
DV-PAL Is 4:2:0)
480 60i (30P, 24P, 24PA) NTSC Bl =S
576 50i (25P) PAL 2

*O) KRR - GARBIMSRR)

GPI F1 RS-232C #1128 (1 x 3.5 22 KRR AR$ 52 )

15V Hift, 7.5W
TRARA A Sk
SERI AT PREN, Al R AR E ] CRZIZAT 90 4041

55 / P53 / B [B) R ARG

96

25Mb/s i1 50 Mb/s, 8 4‘1 4:1:1 (NTSC-DV) 5% 4:2:0 (PAL-
DV) #i45 (@ F%5) . DVCPROHD REC (100 Mb/s)
AT RalCk B DVCPROHD BN Y 1394 1) (1)
720 50p/60p A1 1080 50i/60i #4H (HykT-A1E) .

DV Wk TR CEmiEAs D

DV &5

DVCPROHD %I\, Mtk 4 Fiili. 48kHz. 16 7.
DVCPRO50 fii N\, EAANHL 4 FHiE. 48kHz. 16 i,
DVCPRO/DV #ii N\, #HIANHK 2 FiE. 48kHz. 16 (75 4
FIE. 32khz. 1217

Ohote

DTE {X3#F 4 38, 12 {i. 32kHz. RawDV JX#H=HIZT.
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DTE 8

DVCPRO/DV Fixt:

RAW DV

AVITYPE 1

AVI TYPE 2

MATROX AVI

CANOPUS AVI
QUICKTIME

AVID OMF

AVI Type 2 24p {2RF NTSC,
QUICKTIME 24P {2/ F NTSC
PINNACLE

P2

MXF OPla

DVCPROHD F1 DVCPRO50 £i5L

RAW DV
P2

HEER

W HEAL2E . 100GB, 5400RPM, 8 MB Z21%
WEEE# 2 FAT32

FS-100 5 Windows 98SE. ME. 2000. XP Fl Mac 0S9/10
FHAER o
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REUOK BTSSR B REAS: BN, FS-100 #Bs A — AN ScAH &
1, FRFR RSB BT AR 23R I A D645 B . (5 BT

o BUERARR

o BUEHON / HrHUE TC{H

o BYBEFRELI (]

o BURRRN (CGRAISCMEZRAD .
H B SO IR AR TR S5 30 0] 97 78 22 A7 I R AN A2, B30 AT i R
A R A A R A5
BIREE
FS-100 LCD ‘27 5 L BE I v] 8 B LA R B . XLy 5 H
() A e A8 2 e B R VT B 52 M FS-100 4247, FNIHAIH T
BRI SR DR AT DR EX PR 4

HEIRHS ik B1E

LOW BATTERY! At B . 1B AC BIRS EIREhE.

HIGH e EH, TEERIET. 1BERRIRIE X FLAN X B S FLEGIE JobE .

TEMPERATURE!

NO SPACE LEFT! | @&Ei#. TR REIZAT, ESHHE FRTH
FAEX LS.

DISK ERROR HWEEMITHE. i& 5 Focus Enhancements 3% R % 3%

XXX BKAE.

NO DISK HWEEMITHE. i& 5 Focus Enhancements 3% R 3% 3%

DETECTED BE.

WRONG BT IR O BT HEM SR ERAR.

PRODUCT ID

FILENOT FOUND | sr#f&$8iRer st BB RRAF R REFE.
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Hith s
fwxdc.dat
fwxde.dat SCAIE—NEAESCAE,  H T4 R i R AR
B SCAF ISR RE o 12T FS-100 [FIRERHAR H % R
&
« 24, FS-100
s 90 K, B CEHItD

HhES5ER
o IBATIRAS 50 JHK / AEIEATIRA 100 K
e 5Hz 3] 60Hz 1G 16 EIRIH

o IBITHELE: 0-35°C (35-95°F)

o IBfTERE: 30% F 90% RH

o fEIRELE: -20 £ 60° C (-4° F] 140° F)
o GBI 85% RH B

REBR GO
T kR EALS R, 155 7% www.focusinfo.com.
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